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PROFILE© EXPRESS 

OWNERS MANUAL 
 

Released April 8, 2004 
 
 

1. Introduction 
 

Rofile Express is a PC compatible software designed to be used with the Vericom VC3000 Brake Meters.  
Profile Express is a simplified version of Profile Professional.  It is an easy to use, intuitive windows 
program so even beginning computer users can utilize this powerful tool.  With Profile Express you can: 
 

• Organize and analyze data 
• Compare data 
• Save data to disk 
• Graph a single run 
• Display data in a table format 
• Make presentation quality Prints 
• Retrieve data from disk 
• View the average of many runs 
• Display the results of many runs in one window 
• Save and reopen a table of runs 

 
Profile Express's help is context sensitive, which means that when you press F1 you get help on the subject that 
the cursor is near. 
 
 

2. Hardware Requirements 
 
The computer must be 100% PC compatible and running Windows 95 or higher and have an unused RS232 
serial communications port.  The RS232 port is for communicating with the VC3000.  Any printer compatible with 
Windows will work with Profile Express. 
 
 

3. Installing Profile Express 
 
For Windows 95/98/NT/me/2000/XP: 
 
1. Close all Windows applications. 
2. Insert Profile Express Installation CD into your CD-ROM drive. 
3. If setup doesn’t automatically start, then from the Start menu, choose Run. 

a. In the Run dialog, type d:\setup.exe, where d is the letter of your CD-ROM drive. 
b. Press Enter. 

4. The installation program will guide you through the short installation process. 
5. Once installation is complete select Start, Programs, Vericom Computers, Profile Express, Profile Express to 

run the program. 
 
We have included some example tests.  To open the examples provided use File|Open… or press F4. 
 
 

4. Quick Start Using Profile Express 
 
When Profile Express starts you have the option of opening a run or importing new runs. 
 

P 
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Importing 
 
1. Turn the VC3000 Brake Meter on and connect it to the serial port of your computer. 
2. Select Import|Auto (or Auto Import Icon) in Profile Express to import the run headers from the VC3000 to 

Profile Express. 
3. Now you have the option to open each run to a window, save the runs to disk, or delete the runs.  When you 

import each run, this window appears: 

 
 
4. Save the run to disk after uploading is complete and header information is completed. 
 
See page 2 for details on uploading. 
 
Opening a saved run 
 
A file saved with Profile Express can be opened by Profile Express.  It has the default extension .PER but any 
extension will work.  Use File|Open, click the open icon or press F4 to open the Open dialog box.  To change the 
file type filter to all files select *.* from the file type drop down box.  Select a file by double clicking on it or select it 
then click on OK in the dialog box. 
 
Previously opened files can also be chosen from the File menu in Profile Express.  A list of the most recent 5 
opened files is at the bottom of the File menu.  Select a filename to open it. 
 
Saving a run to disk 
 
To save a run to disk after making a new run or modifying one select File|Save (Ctrl+S) or File|Save As....  If the 
file is new or if Save As... is chosen a dialog box will open and you will need to type in a filename.  The filename 
can be any valid windows filename.  Profile Express's default extension is .PER but any extension can be used. 
 
 

5. Importing Data 
 
Automatic import uses the serial port of your computer.  See COM port and baud rate in Options on page 15. 
 
Turn on the VC3000 and plug it into the RS232 COM port.  Go to Import|Auto, or click on the icon, or press 
Ctrl+I.  Profile Express will instantly import the available headers into temporary memory. 
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Folder names 
Profile Express will create a folder with the current date and time as a new folder name and will select it.  If you do 
not want to save the data in that folder, click on the folder you want to save the data in, or create a new one.  The 
default data folder may be changed by selecting a different folder from the window, or click the "Change or Create 
Folder" button to open a folder on another drive or on a network, or to create another folder to put the data into.  
To create a new folder, once the dialog box opens browse to the folder you want to create a new folder in, click on 
the "Create New Folder" button and type a new folder name.  Then click Open to select it. 
 
If you do not save the data in the folder created automatically by Express, Express will delete the folder so you do 
not have empty folders on your computer. 
 
Select the To new run window button to import the data and put the run in a window.  Then the data can be 
viewed, graphed or saved. 
 
When the Save As button is used for the individual runs, Profile Express will import the data then give you the 
opportunity to name the run and select a folder to put it in. 
 
Click the Delete button to take the run out of the Import window.  This does not delete the run from the VC3000. 
 
When one of the Save buttons in the Automatically Name box are used, Profile Express will automatically choose 
a file name of "Runxxx.run", where xxx is the run number preceded by zero's, and continue using the Run 
Number from the VC3000.  Profile Express will put the files in the Default Data Folder shown in the Save To Disk 
box. 
 
Use Save All to save all the runs in the Import window to disk. 
 
Use Save Checked to only save those runs that you manually checked. 
 
The default data folder may be changed by selecting a different folder from the window, or click the "Change or 
Create Folder" button to open a folder on another drive or on a network, or to create another folder to put the data 
into. 
 
 

6. VC3000 Setup 
 
This window shows all the variables that can be changed in the VC3000.  Use this setup in Profile Express to 
view and change all the VC3000 settings in one convenient place.  These settings only affect the VC3000 and will 
not change the Profile Express settings. 
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Buttons on the window: 
• Get Setup:  Gets the setup stored in the VC3000. 
• Send Setup:  Sends the new setup to the VC3000.  No information is sent to the VC3000 until this button 

is pushed. 
• Set Clock:  Sets the clock in the VC3000 to the time on your PC. 
• Recall Factory: Set the variables to the factory default values. 
• Save User:  Saves the current setup to your computers hard drive for later recall. 
• Recall User:  Recalls the setup from the last time Save User was pushed. 

 
Send Setup must be clicked to send the changes to the VC3000. 
 

 
 
Units: 
Metric or English units can be displayed by the VC3000. 
 
Calculate Distance: 
The VC3000 will calculate the braking distance for an exact speed if the actual speed is within 5 mph of the target 
speed.  20 mph and 60 mph are common, but any speed can be used.  The distance is calculated assuming the 
vehicle was going exactly the target speed. 
 
Pitch and Roll Factor: 
See Pitch and Roll Factor on page 9. 
 
G smoothing: 
See G smoothing on page 9. 
 
Trigger: 
The VC3000 can be started by a countdown, by a G force threshold or by an external activation.  If you don’t want 
the G-threshold to start the run, set it high, 0.500 G for example.  Check the Countdown mode to activate the run 
after a countdown sequence. 
 
User Type: 
Changing the user type changes the data that is displayed after a test and when runs are selected from memory.  
In some cases it will change how the test starts and will change other user settings. 
 
Accident Reconstruction: 
Display – Brake mode: 

• Reaction Time 
• Reaction Time distance 
• Elapsed Time 
• Speed 
• Distance 
• Avg. Gx 
• Avg. Gy 
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• Peak Gx and the time it occurred 
• Peak ± Gy 
• G every 0.10 sec. 
 

Display – Acceleration mode: 
• Time to programmed parameter 
• Speed to programmed parameter 
• Distance to programmed parameter 
• Avg. Gx 

 
Transit: 
Display – Brake mode: 

• Reaction Time 
• Reaction Time distance 
• Elapsed Time 
• Speed 
• Distance 
• Adjusted Distance to predetermined speed 
• Avg. Gx 
• Avg. Gy 
• Peak Gx and the time it occurred 

• 1st Peak Gx and the time it occurred under 0.75 seconds 
 

Display – Acceleration mode: 
• Time to programmed parameter 
• Speed to programmed parameter 
• Distance to programmed parameter 
• Avg. Gx 

 
OT - Rehab: 

• Does not zero the accelerometer before a run 
 
Display – Brake mode: 

• Reaction Time 
• Reaction Time distance 
• Elapsed Time 
• Speed 
• Distance 
 

Display – Acceleration mode: 
• Time to programmed parameter 
• Speed to programmed parameter 
• Distance to programmed parameter 
• Avg. Gx 

 
Advanced: 
Display – Brake mode: 

• Reaction Time 
• Reaction Time distance 
• Elapsed Time 
• Speed 
• Distance 
• Adjusted Distance to predetermined speed 
• Avg. Gx 
• Avg. Gy 
• Peak Gx and the time it occurred 

• 1st Peak Gx and the time it occurred under 0.75 seconds 
• Peak ± Gy 
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• G every 0.10 sec 
 

Display – Acceleration mode: 
• Time to programmed parameter 
• Speed to programmed parameter 
• Distance to programmed parameter 
• Waypoints 
• Avg. Gx 
• Avg. Gy 
• Peak Gx at time, speed, dist 
• Peak Gy at time, speed, dist 
• Peak HP at time, speed, dist, torque, RPM 

 
Vehicle I.D. is a 6 digit number identifying the vehicle.  The I.D. will print on the thermal printer and will also 
display in the vehicle field when imported to Profile Express. 
 
Suspension Settle Time: 
See suspension settle time on page 9 or Brake test calculations on page 10. 
 
Click on the next General tab (“General…”) to see the less commonly changed VC3000 settings. 
 

 
 
Zeroing On 
Turn zeroing for the accelerometers on or off.  When zeroing is turned off the VC3000 assumes a perfectly level 
surface.  The accelerometers are normally zeroed for incline and temperature changes, but in some cases that 
may not be desirable.  For example if you cannot come to a complete stop to push buttons before the test. 
 
Graph Range: 
The X and Y axis range of the graphs on the VC3000 can be changed to anything from 0.1 to 2.0.  This range 
only affects the maximum range of the bar graphs and friction circle in continuous mode. 
 
Vehicle Weight is the curb weight of the vehicle.  Vehicle weight is used in horsepower and torque calculations 
only. 
 
Roll-out Distance is the distance the vehicle must travel before the timer, speed and distance start in the 
VC3000.  At a dragstrip for instance the roll-out is generally about 12 inches if you shallow stage.  By using the 
roll-out distance, the VC3000 time and the dragstrip time will match more closely.  The VC3000 actually logs all 
the data, even before the roll-out distance so it can send that information to Profile Express, but the VC3000 
recalculates the time from the roll-out distance.  Profile Express has its own roll-out distance calculation in Quick-
Stats. 
 
Alarm Threshold: 
If the alarm thresholds are turned on, the VC3000 will beep when that threshold is reached.  Any number greater 
than 0.000 will turn the alarm on, and 0.000 turns the alarms off. 
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Battery %: 
Indicates the battery percent remaining when the "Get Setup" button is clicked. 
 
Baud Rate: 
Indicates the baud rate that the VC3000 is set to. 
 
Send Setup must be clicked to send the changes to the VC3000. 
 
 

7. Header Information 
 
The information such as vehicle name, location, date, etc. is called the header for the run.  Select View|Header 
from the menu or click on the Header tab at the top of the run page and all run header variables for the run will be 
displayed.  Following is a description of each header variable. 
 

 
 
Vehicle and Location: 
Up to 30 characters each. 
 
Date and Time: 
The VC3000 will send the date and time that the test was performed. 
Run Number: 
The run number will be uploaded automatically from the VC3000. 
 
Run Length: 
Length of the run in seconds.  This field cannot be modified.  In brake runs you may notice that when uploading 
the run the time is about 0.20 seconds greater than the run length of the VC3000.  It will be readjusted after the 
run is uploaded.  See page 10 for more information on brake run time. 
 
Weight: 
The weight is for Horsepower and Torque calculations only.  It should include vehicle and passenger weight.  
Weight is uploaded from the VC3000 when the run is transferred to Profile Express.  It can be changed in at any 
time and Profile Express will recalculate HP and Torque. 
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8. Viewing Data 
 
Select View|Data from the menu or click on the Data tab at the top of the run window and all data available for the 
run will be displayed.  Brake runs will have only Time, G, Speed, Distance and Lateral G.  In an acceleration run 
Time, G, Speed, Distance Lateral G and HP are shown.   

 
 
Printing the data 
The entire table of values of the current open run can be printed.  First open a file.  Next select File|Print….  A 
dialog box will open allowing you to choose Print Preview, Print to selected printer, or save to a file.  It will save 
the report to a NDR report format, a PRN native printer file, a PDF file, TXT text file, RTF Rich text format file or 
an HTML web file. 
 

 
 
 

9. VC3000 Settings 
 
The settings show how the VC3000 was setup for each run.  This tab is mostly for reference, but some values 
may be changed.  Suspension Settle time, Pitch and Roll Factor and Smoothing factors may be changed to finely 
adjust the data. 
 
The original values are not editable.  They are the values the VC3000 had when the run was performed.  The 
Trigger box shows how the VC3000 started, with a G Force threshold, external switch or countdown mode. 
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Suspension Settle time 
In a braking test the G values for the suspension settle time at the end of the run, usually 2 tenths of a second, 
are not used in any calculations because these values are a result of the suspension settlement.  In eleven years 
of testing we have found the suspension settle time to vary 0.14 to 0.23 seconds.  Varying the settle time by +- 
0.09 sec. makes very little or no difference in the average G calculations.  It will have the most effect on the 
distance calculation.  You will notice the complete test including the suspension settle time is included in the 
graph but the calculations do not include the suspension settle time G values. 
 
To change the suspension settle time use the VC3000 Settings tab for the run.  The settle time will show how the 
VC3000 was set up and allow you to enter a new time.  The Original time is the settle time that was programmed 
into the VC3000 and not editable. 
 
Pitch and Roll Factor 
The Pitch and Roll factors are numbers that Profile Express multiplies with G.  By typing in 1.03 Profile Express 
will multiply every G value 1.03.  By changing the Pitch factor; G, distance, speed, horsepower and torque are 
affected.  By changing the Roll factor only Lateral G is affected.  Generally the Pitch factor and Roll factor should 
be 0.970.  The VC3000 Pitch factor and Roll factor are passed to Profile Express so the data will match. 
 
The only time the Pitch factor should be adjusted in Profile Express is if you did not adjust the Pitch factor in the 
VC3000.  The only time to adjust the Pitch factor in the VC3000 is if vehicle is an experimental or non highway 
vehicle such as rail cars or boats or for low friction surfaces like ice when the average G is less than 0.250 G.  For 
example when brake testing on ice the Pitch factor in the VC3000 should be set to 0, not the default 1.  This is 
because the suspension tilt is nominal.  This will affect all the calculations made by Profile Express. 
 
G smoothing 
Smoothing is used to eliminate some of the vibration associated with vehicle testing.  Smooth factors from 0 to 9 
may be entered.  The smooth factors affect the VC3000 calculations very little.  The G data sent to Profile 
Express is the raw data before smoothing and Profile Express uses the VC3000’s smooth factor by default, but 
can be changed for more or less smoothing effect. 
 
The thick line is a smooth factor of 3 and the jagged line has no smoothing. 
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10. Brake Test Calculations 
 
In a braking test the G values for the suspension settle time at the end of the run, usually 2 tenths of a second, 
are not used in any calculations because these values are a result of the suspension settlement.  In eleven years 
of testing we have found the suspension settle time to vary 0.14 to 0.23 seconds.  Varying the settle time by +- 
0.09 sec. makes very little or no difference in the average G calculations.  It will have the most effect on the 
distance calculation.  You will notice the complete test including the suspension settle time is included in the 
graph but the calculations do not include the suspension settle time G values. 
 
To change the suspension settle time use the VC3000 Settings tab for the run.  The settle time will show how the 
VC3000 was set up and allow you to enter a new time.  The Original time is the settle time that was programmed 
into the VC3000 and not editable. 
 
When comparing the VC3000 to other methods of speed, distance or drag factor calculations, be sure you 
understand how the VC3000 works.  For instance:  When comparing a bumper chalk gun distance to the VC3000 
distance the two have to trigger at the same time.  This means using the external activation switch of the VC3000 
and connecting it to the same source that activates the bumper chalk gun.  Since mechanical reaction time is now 
included in the VC3000 calculations drag factor is not correct for the road surface.  To compensate for this use 
Calc Average to eliminate the mechanical reaction time.  Find the time from the graph or data where the VC3000 
first reaches 0.200 G.  Use that as the start time and use Profile Express's default end time (DO NOT include the 
suspension settlement). 
 
To measure true drag factor it is recommended that the VC3000 be activated by its default 0.200G threshold. 
 
When comparing speed it will not make a significant difference whether the VC3000 is started using the brake 
lights or the 0.200 G threshold. 
 
Notice that when distance is used to calculate average G, error in average G can occur.  This is due to the fact 
that the calculation assumes constant G and in a typical skid, G is not constant.  Summing the G samples and 
dividing by the number of samples is the true scientific way to get average G and Drag Factor.  Using the speed 
divided by time method is same as summing the G samples and dividing by the number of samples since speed 
is the area under the Time-G curve. 
 
 

11. Stats for acceleration runs 
 
Quick stats is used for retrieving statistical data from the run similar to the displayed statistics from the VC3000.  
Click on the Stats tab then click the for Quick Stats button.  Time at the distance points is interpolated to the 
nearest 1/1000th of a second.  Average HP is calculated up to the time, speed or distance point.  In the case of 
the range 35MPH to 70MPH the Average is within the range.  The range 35MPH to 70MPH is an example of a 
range to select when looking for the peak Horsepower in one gear.  Generally 70 MPH is where wind resistance 
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decreases Horsepower.  HP in lower gears is reduced by the amount of power it takes to increase the speed of 
the mass of the lower gear ratios. 
 
"---at Pk HP" and "---at Pk Torq" refers to the statistics within the range above it. 
 

 
 
 
When the window appears for the first time it displays the default statistics and no Rollout Time.  Click on the 
"Show Rollout Calculations" check box to subtract the Rollout time from the time to distance points. 
 
Comments can be included for printing in the last column for each row. 
 
 

12. Stats for braking runs 
 
Quick stats is used for retrieving statistical data from the run similar to the displayed statistics from the VC3000.  
Click the tab for Stats.  An adjusted distance can be calculated if the target speed is within 5 MPH of the actual 
speed.  This is because it is impossible to calculate an accurate distance if the speed difference is greater than 5 
MPH.  If the test is close to 20 MPH click the 20 MPH button to calculate what the distance would have been if the 
vehicle would have been going exactly 20 MPH.  Similarly for 60 MPH.  Any other speed within 5 MPH of the 
actual speed can be used by typing it into the box then hitting Enter or clicking the Calculate button. 
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13. Display Average of many Runs 
 
The Time, G-Force, Speed, Distance and HP can be displayed and averaged for many runs.  Any or all of the 
information can be added or removed by clicking next to the information in the check box.  Files must be saved to 
disk to use in Display Average. 
 
Use Tools|Display Average.  When the Open dialog box opens, select one or more runs to open.  If adding more 
runs, select File|Add Run to Avg or click the Add Run button.  Select a saved run from the list.  To add a run to 
the list simply select another run. 
 
To print the table of averages select File|Print…, click the print button, or press Ctrl+P. 
 
To save the table of averages in ASCII form select File|Save As Ascii....  A table saved as ASCII can be opened 
again by Profile Express into Display Average by selecting File|Open....  Then choose the file type Ascii 
files(*.csv).  Choose a saved table from the list of ASCII files. 
 
To save the table for use in a word processor or as text select File|Save As Text....  Text files cannot be 
reopened by Profile Express. 
 

 
 
Brake runs: 
If the test is close to 20 MPH click the 20 MPH button to calculate what the distance would have been if the 
vehicle would have been going exactly 20 MPH.  Similarly for 60 MPH.  Any other speed within 5 MPH of the 
actual speed can be used by typing it into the box then hitting Enter or clicking the Calculate button. 
 
 

14. Graphing 
 
Starting a Graph 
Profile Express will graph time on the X axis and Longitudinal G, Speed, Distance, Lateral G and HP on the Y 
axis. 
 
Click on Graph|Line Graph or press F2.  If no run file is open, select File|Open... or hit F4 to open a file to graph. 
 
Scaling: 
Longitudinal and Lateral G are on the same scale, and Speed, Distance and HP have their own scales. 
 
Once the graph appears the individual Y-axes can be turned off by clicking on the corresponding checkbox.  Click 
it again to make the axis reappear. 
 
Change to the Y axis scaling by clicking on the line next to the axis name. 
 
Zoom in: 
Left click and drag the mouse from upper left to lower right. 
 
Zoom out and re-center: 
Click and drag from lower right to upper left. 
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Scroll graph: 
Right click and drag with the mouse. 
 

 
 
To create another graph while keeping the current graph, click on the Line Graph icon, open a run from disk, click 
the OK button.  Profile Express automatically maximizes the size of the window so use the Restore Down icon in 
the upper left to see both graphs. 
 
*Printing a graph 
A displayed graph can be printed just as it appears on the screen.  Select File|Print and Profile Express will open 
a Preview window.  Click the Print button in the preview screen to print the graph. 
 
The Printer Setup can be changed by using File|Printer Setup... or by clicking on the Setup... button in the 
Preview screen. 
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15. Changing Program Options 
 
Program options such as the units of measure, user type and input port can be changed by the user.  Default 
information for each imported run can also be set in the options. 
 
To modify any of these variables select Tools|Options. 
 

 
 
Units of Measure: 
English:   Time  Seconds (Sec.) 
   Speed  Miles per Hour (MPH) 
   Distance Feet (ft) 
   G-Force G (G) 
   Horsepower HP 
   Torque  Foot Pounds (ft lbs) 
 RPM  Revolutions per minute (RPM) 
   Gear Ratio Revolution per foot (Rev/ft) 
 
Metric:   Time  Seconds (Sec.) 
   Speed  Kilometers per Hour (KPH) 
   Distance Meters (m) 
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   G-Force G (G) 
   Horsepower HP 
   Torque  Newton Meters (NM) 
 RPM  Revolutions per minute (RPM) 
 Gear Ratio Revolution per meter (Rev/m) 
 
COM port: 
The data that the VC3000 sends to the computer is compressed so only Profile Express can be used to import the 
data.  Select Auto for the COM port to let Profile Express automatically search for the VC3000.  When it finds the 
VC3000 it will store the COM port number to disk and scan that port first next time so scanning time will be very 
short as long as the COM port number doesn't change.  If you choose a specific COM port Profile Express will 
only try communications on that one port. 
 
Any COM port compatible with windows will work with Profile Express.  The port must not have a mouse, modem, 
joystick, or any other software running that controls the port in any way. 
 
Default Data Folder: 
This is the default folder (directory) to open .PER files from and save to when the program starts. 
 
Lateral G calculations: 
Check this box to calculate the summation of the vectors of G and lateral G.  The G data will contain the new 
vectored values and speed and distance calculations will be made from it.  This check box has no effect on 
acceleration runs or if no lateral G sensor was used.  Using Yaw data to calculate speed, distance or average G is 
only useful if the vehicles direction of travel is constant.  If the vehicle shows an arcing curve there will be extra 
lateral G due to turning, therefore speed, distance and average G will be too high when using the lateral G for 

calculations.  The calculation is: GVectoredGLatG =+ 22 .  
 
This check box must be checked before opening a run or using Display Average for Vectored G to be accurate. 
 
Header Defaults: 
The Header Defaults page of options is only to set the default header information for imported runs.  These 
settings will be transferred to any new run.  The data typed in here will be used for the header information on all 
subsequent imports.  This saves the time it would take to type in the redundant information for every run. 
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16. Troubleshooting 
 

Problem Solution 

A. 
Profile Express will 
not take data in. 

1. The VC3000 is not turned on or is unplugged. 
2. Wrong COM Port selected.  Go to 

File|Options… and select Auto or the correct 
COM port. 

3. PDA synchronization software such as "Hot 
Sync" is running and controlling the serial port.  
Close the PDA software and try again. 

4. Wrong cable or not connected properly. 
5. Plug notebook computer into power supply. 

B. 
"COMx could not 
be opened" or 
“Output buffer too 
small for block” 

1. The VC3000 is not turned on or is unplugged. 
2. Wrong COM Port selected.  Go to 

File|Options… and select Auto or the correct 
COM port. 

3. PDA synchronization software such as "Hot 
Sync" is running and controlling the serial port.  
Close the PDA software and try again. 

C. 
Error message 
“Wrong response 
reading file count” 

1. Wrong COM port selected.  Go to 
File|Options… and select Auto or the correct 
COM port. 

D. 
Error message 
"ie_Hardware - 
hardware not 
present". 

1. The Com Port is locked or in use by another 
device.  Disable the other device or try another 
Com Port. 

2. The Com Port doesn't exist in the computer.  
Select a different Com Port. 

3. The driver software for the port is not present.  
Reinstall the port software. 

4. The resources (address space and interrupt) in 
BIOS must match that of windows.  To check 
BIOS settings enter SETUP when the 
computer first boots up. 

E. 
Error message 
"ie_Open - device 
already open" 

1. The COM port is locked or in use by another 
device.  Disable the other device or try another 
COM port. 

2. Profile Express or another program opened the 
port but didn't close it.  Exit Profile Express 
and restart it.  Or try closing any DOS 
applications.  Or you may have to restart your 
computer. 

F. 
“Profile Express 
will only read data 
from the VC3000 
Brake Meter” 

1. You are trying to import from a VC3000PC or 
DAQ model.  Only brake meters will import into 
Express. 

 


